
Direct

Creating a
Performance Report

Exercise Guide



Morningstar Direct January 2020
© 2020 Morningstar. All Rights Reserved.

Copyright © 2020 Morningstar, Inc. All rights reserved. 

The information contained herein: (1) is proprietary to Morningstar and/or its content providers; (2) may not be copied 
or distributed; (3) is not warranted to be accurate, complete or timely; and (4) does not constitute advice of any kind.  
Neither Morningstar nor its content providers are responsible for any damages or losses arising from any use of this 
information. Any statements that are nonfactual in nature constitute opinions only, are subject to change without 
notice, and may not be consistent across Morningstar. Past performance is no guarantee of future results.



Morningstar Direct January 2020 3
© 2020 Morningstar. All Rights Reserved.

Contents

Overview . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4

What is involved in creating a performance report? . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5

Scenario. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5

Solution . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6

Exercise 1: Searching for the cheapest share class of a fund . . . . . . . . . . . . . . . . . . . . . . 6

Create a search by criteria in Performance Reporting . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 8

Exercise 2: Change the settings for the group . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 10

Exercise 3: Set the values for the Time Periods tab . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 14

Exercise 4: Set the values for Data Points and Ranks  . . . . . . . . . . . . . . . . . . . . . . . . . . . 15

Exercise 5: Select options from the Supplementary Columns window . . . . . . . . . . . . . . 18

Exercise 6: Rename a data column. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 20

Exercise 7: Save the performance report . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 21

Exercise 8: Calculate the performance report  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 22

Exercise 9: Apply conditional formatting to a performance report  . . . . . . . . . . . . . . . . . 23

Exercise 10: Apply conditional formatting to the Morningstar Analyst Rating . . . . . . . . . 24

Exercise 11: Generate a Scorecard for a set of investments . . . . . . . . . . . . . . . . . . . . . . . 29

Exercise 12: Add a summary column for various scores  . . . . . . . . . . . . . . . . . . . . . . . . . . 31

Exercise 13: Save investments to a list . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 33



Morningstar Direct January 2020 4
© 2020 Morningstar. All Rights Reserved.

Creating a Performance Report

OverviewThe Morningstar Rating for a fund is a starting point for evaluating a fund’s 
risk-adjusted performance, but it is also important to consider the consistency of a 
fund’s performance over time so you understand whether investors can rely on regular 
out-performance from the management team. 

A performance report, which shows rows of investments and columns of data about 
those investments, allows you to evaluate which funds have exhibited consistent 
performance. The Performance Reporting module in Morningstar Direct not only 
displays return and category rank data from multiple time periods more easily than in 
other parts of the application, but also allows you to use tools such as grouping, 
conditional formatting, and a scorecard to calculate results and present data in an 
easy-to-understand format.

This sample performance report 
reflects the use of both conditional 
formatting and score columns.
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What is involved 
in creating a 
performance report?

Creating a performance report consists of the following steps: 

1. Select the investments for the report.

2. Decide how the investments will be grouped together, what the investments on the 
report should be compared to, and select comparison and calculation benchmarks for 
the investments on the report.

3. Choose the time periods (trailing 1-year, rolling window, etc.) to display, and data points 
(Return, Category Rank) to display in each time period.

4. Choose supplementary information you want to include outside of the time periods.

5. Apply conditional formatting to call out important information.

6. Use a scorecard to calculate results over time.

ScenarioYour manager wants to understand the consistency of Large Growth open-end funds. 
Which of the funds have had truly reliable performance during the past five years? 
Your manager wants to you to produce a report identifying consistent Large Growth 
funds. Each fund must meet the following criteria:

g still open to new investors
g an above-average Sharpe Ratio for the trailing five-year period when compared to 

their category peers
g an expense ratio below the category average
g a Downside Capture Ratio for the five-year period below 100, and
g only the cheapest share class of a fund should be considered.

The report should show returns and category ranks for rolling three-year periods, 
starting from five years ago through the most recent month end. 

In the following exercises, a fund will be considered a consistent top performer if it has 
appeared in the top quarter of its category during all of the 25 time periods being 
considered. If a fund has a Morningstar Analyst Rating, your manager wants to see 
that, but funds are not required to have an analyst rating in order to be considered a 
top performer. Finally, the Sharpe Ratio should also be shown, but only for the most 
recent three-year period.
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SolutionIn this performance report, you will search for the investments to consider, then 
configure the performance report to retrieve the proper time periods and data points. 
Conditional formatting will be used to highlight both funds appearing in the top 
quartile for each time period, and the Morningstar Analyst Rating (where available). 
Finally, a scorecard will be employed to determine whether funds have consistently 
appeared in the top quartile of their respective Morningstar Category.

Exercise 1: Searching 
for the cheapest 
share class of a fund

When creating an advanced search to find only one instance of a fund (rather than 
seeing all share classes of a fund), you have a number of options, including looking for 
the following:

g the oldest share class of a fund
g a specific share class for a fund, such as the A share, or
g the least expensive share class for a fund. 

Before conducting an advanced search to look for the cheapest share class for a fund, 
you need to set the proper user preference to allow for this. Do the following:

1. From the menu bar at the top of the Morningstar Direct window, select 
File…Set User Preferences. The Set User Preferences window opens.

Select this option 
from the File menu.
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2. Select the User Defined Primary tab.

3. Select the row for Annual Report Net Expense Ratio, then click the move to top 
button. (The move to top button displays two up arrows.) This ensures this criterion takes 
precedence when conducting a search.

4. Be sure the word Lowest appears in the Choose column.

5. Click OK. In the next exercise, you will learn to leverage this setting.

Use this button to 
move the selected 
item to the top of the list

Be sure to select this tab.
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Create 
a search by criteria in 
Performance Reporting

The first step in identifying consistently top performing large cap funds is to search for 
those open-end funds that meet the following criteria:

g an expense ratio below the category average
g still open to new investors
g an above-average Sharpe Ratio for the trailing five-year period, when compared to 

their category peers, and
g a Downside Capture Ratio below 100 for the five-year period.

To create a search by criteria in the Performance Reporting module, do the following:

1. In Morningstar Direct, select the Performance Reporting tab. The Folders page should 
be selected by default.

2. From the toolbar above the grid view, click New. The Select Investments dialog box 
opens.

3. Select the option for Search Criteria. Be sure the Open End Funds option is selected 
from the drop-down field.

4. Click OK. The Search Criteria dialog box opens.

Click this icon to create a 
new performance report

Be sure to select this 
option to find 
investments based on the 
parameters you choose

Be sure this option is selected 
to find investments based on 
the parameters you choose
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5. Set your criteria as shown in the following table:

 Note: At the bottom of the Search Criteria dialog box, be sure to check the checkbox for 
User Defined Primary Class Only.

 

6. Click OK. The Group Settings window opens.

Rel ( Field Name Operator Value )

-- Morningstar Category = US Large Growth

And Annual Report Net Expense Ratio < CAT AVG

And Closed to New Inv Not= Yes

And Sharpe Ratio 5 Yr (Mo-End) > CAT AVG

And Downside Capture Ratio 5 Yr (Mo-End) < 100

And Inception Date <= 01/01/2015

Be sure your search 
reflects the inputs 
shown here.

When looking for 
criteria in the Field 
Name column, it 
helps to select the 
Alphabetically 
option, to see all 
criteria at once.

Be sure to check 
this box as w.ell
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Exercise 2: Change 
the settings for the group

By default, when examining the performance of selected funds in a performance 
report, Morningstar Direct compares the funds to each other, rather than all of the 
funds in the appropriate Morningstar Category. In this section, you will learn how to 
change the peer group for a set of funds. 

In a performance report, it is also important to use a relevant benchmark for both the 
performance comparison and performance calculations. You can also decide whether 
to display only one comparison benchmark (rather than the default two benchmarks).

To change these settings for a performance report, do the following:

1. In the Peer Group column for row 1, click the Peer Group icon. The Peer Group dialog 
box opens.

2. Select the Morningstar Category option. 

3. Click OK to close the dialog box.

Click this icon to change the 
peer group for the report

This option allows you to 
compare the funds from 
your search to all other 
funds in their category
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4. In row 1, from the Display Benchmark 1 drop-down field, select 
Morningstar Category Index.

5. To see what the benchmarks are for each category, from the toolbar, click 
Show Benchmarks.

6. From the toolbar, click Report Settings. The Report Settings dialog box opens. From 
here, the second display benchmark can be hidden.

Select this option to 
assign an index to 
the category in the 
performance report.

This icon allows you 
to see the name of 
each index that will 
appear on the report.

Use this icon to display 
just one comparison 
benchmark on the 
performance report.
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7. Uncheck the Show display benchmark 2 checkbox.

8. Click OK to close the Report Settings dialog box. 

Uncheck this box to 
ensure only one 
benchmark appears on 
the performance report
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9. Next, you need to ensure the proper benchmark is used for calculating the data on 
the performance report. From the Calculation Benchmark drop-down field, select 
Display Benchmark 1. This allows you to use the same benchmark for both display 
and calculation. It also ensures a peer-appropriate index is being used for 
calculation purposes.

10. Click OK. The Select Column dialog box opens. 

11. Make sure the option for User Defined is selected, then click OK. The Performance 
Column Setup window opens.

Note the selection 
from this 
drop-down field.

This option should be 
selected by default.
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Exercise 3: Set the values 
for the Time Periods tab

To see if this set of funds has had consistent performance over a set of rolling 
three-year periods starting from five years ago, do the following:

1. In the Performance Column Setup, select the Rolling window option.

2. From the Start Date field, select Enter Date, and select the first day of the current month 
from five years ago. 

3. From the End Date field, select Last Month End.

4. From the Window size drop-down field, select 3 years.

5. From the Moving step drop-down field, select 1 month. The Number of columns field 
should read 25.

6. Click Add Columns. The time periods for the report are added to the Selected Time 
Periods area.

 Note: Do not click OK yet; the Data Points and Ranks tabs still need to be addressed.

Be sure to select this 
option for Time Periods.

Be sure to select 
the correct values for 
Window size and Moving step.

Note the values for the 
Start Date and End Date fields.
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Exercise 4: Set 
the values for 
Data Points and Ranks

Remember that your manager requested to see not only the return for each time 
period, but also the Sharpe Ratio for only the most recent time period. To set the 
values for the two remaining tabs in the Performance Column Setup window, do 
the following:

1. Select the Data Points tab, and ensure Return is displayed in the Selected Data 
Points list.

2. To see the Sharpe Ratio value for the funds, but only for the most recent time period, 
at the bottom of the window, uncheck the box marked Apply add/remove to all 
time periods.

Be sure to select 
the correct tab.

The Return data 
point is included 
automatically in a 
performance report.
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3. From the Time Period drop-down field at the top of the window, scroll down to select 
the most recent time period.

4. In the Data Points list, scroll down until you see the Sharpe Ratio data point, then 
double-click Sharpe Ratio to add it to the Selected Data Points area.

Be sure to select 
the latest time period.

Double-click this data point.

This box must be 
unchecked to ensure the 
data point is added only to 
the time period you select 
at the top of the tab.
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5. Select the Ranks tab, and ensure only Peer group percentile is selected in the Selected 
Rank Columns list.

6. In the Selected Rank Columns list, double-click Peer group percentile. The 
Display Setting dialog box opens.

7. In the Display Name field, type Peer group %.

8. Click OK to close the Display Setting dialog box, then click OK to close the 
Performance Column Setup window. The Supplementary Columns window opens.

Be sure to select 
the correct tab.

Only this field 
is selected by 
default on this tab.

Type the new name for 
the Display Setting here.
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Exercise 5: Select options 
from the Supplementary 
Columns window

In addition to seeing the name of a fund on the performance report, it will also be 
useful to include the fund’s ticker symbol. Also, your manager asked to see a 
Morningstar Analyst Rating if one is assigned to the fund. To include a fund’s ticker 
symbol and Analyst Rating on the performance report, do the following:

1. On the Supplementary tab, in the Available Supplementary Columns list, double-click 
Ticker to move it to the Selected Supplementary Columns list.

2. In the Selected Supplementary Columns list, select Ticker and click the up arrow to 
move it above Name.

Note the position of the 
two selected columns.



Creating a Performance Report Exercise 5: Select options from the Supplementary Columns window

Morningstar Direct January 2020 19
© 2020 Morningstar. All Rights Reserved.

3. Scroll down in the Available Supplementary Columns list, and double-click 
Morningstar Analyst Rating.

4. Click OK to close the Supplementary Columns window. The performance report is now 
ready to be saved and calculated.

Be sure to double-click the 
Morningstar Analyst Rating, 
and not the Morningstar Rating.
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Exercise 6: Rename 
a data column

Only the most recent time period has the correct label for the Peer group percentile 
column; the others were not renamed to Peer group %. To correct this for all other time 
periods at once, do the following:

1. From the toolbar above the grid, from the Edit drop-down field, select Manage 
Columns. The Manage Columns dialog box opens.

2. Scroll down to the row where Peer group % is shown.

3. Hover your mouse over the Peer group % cell. 

4. Click Apply change to all. 

 Note: You could also click in a row to manually rename “Peer group percentile” to 
“Peer group %,” but this would take much more effort.

5. Click OK to close the Manage Columns dialog box.

Select this option from 
the Edit drop-down field.

This button is not seen 
until you hover the 
cursor over this area.
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Exercise 7: Save the 
performance report

Now that the parameters for the report are set, the last step before calculating it is to 
save it. To save the performance report, do the following:

1. From the toolbar above the spreadsheet grid, click Save. The Save Report dialog 
box opens.

2. In the Name field, type Consistent Large Growth Funds.

3. Click OK. The Save Report dialog box closes.

This icon allows you to save 
your work when creating 
a performance report.

Note the name 
to enter for this report.
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Exercise 8: Calculate 
the performance report

To calculate the performance report, do the following:

1. From the toolbar above the grid view, click Calculate. During the calculation, the Folders 
page is displayed.

2. When the Report Calculation Complete message opens, click Yes to view the report. The 
spreadsheet grid is now filled with data.

This icon allows you 
to generate a 
performance report.

Note the data now 
available in the report.
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Exercise 9: Apply 
conditional formatting 
to a performance report

The information in the performance report is great, but it is also a bit difficult to read 
without some additional formatting. The conditional formatting feature in the 
Performance Reporting module allows you to color each row, cell, or column to aid the 
interpretation of the data. 

In this exercise, you will apply a color to the Peer group % column to call out the times 
when each fund was in the top quartile of its category. To apply conditional formatting 
to a performance report, do the following:

1. From the toolbar above the grid view, from the Tools drop-down field, select 
Conditional Format…Conditional Formatting. The Conditional Formatting Rules dialog 
box opens.

2. From the Field Name drop-down field, expand the All Time Periods option and select 
Return : Peer group %.

Select this 
option to 
highlight 
information on 
the report

Be sure to select the 
correct option here
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3. From the Operator drop-down field, select <=.

4. In the Value field, type 25.

5. From the Cell Color drop-down field, select green in the upper-right corner.

6. Be sure the box for Column Only is checked.

7. Click Preview to ensure the rule is working as expected.

8. Click OK. The Conditional Formatting Rules dialog box closes.

Exercise 10: Apply 
conditional formatting 
to the Morningstar 
Analyst Rating

In addition to highlighting funds when they appeared in the top quartile, you can also 
apply conditional formatting to the Morningstar Analyst Rating column, to help these 
values stand out. Do the following:

1. From the toolbar above the grid view, from the Tools drop-down field, select 
Conditional Format…Conditional Formatting. The Conditional Formatting Rules 
dialog box opens.

2. Click Add Rule. Rule 2 now appears.

Note all of the highlighted 
values for this first rule.

Click this button to add 
another formatting rule.



Creating a Performance Report
Exercise 10: Apply conditional formatting to the Morningstar Analyst

Rating

Morningstar Direct January 2020 25
© 2020 Morningstar. All Rights Reserved.

3. From the Field Name drop-down field, select Morningstar Analyst Rating.

4. The Operator field should show =. 

5. From the Value field, select Gold.

6. From the Cell Color drop-down field, click Custom. The Custom Color dialog box opens.

7. Set the following values:

g Red = 250
g Green = 164
g Blue = 29

8. Click OK.

9. Be sure the Column Only box is checked.

Note the values 
for this rule.

Use this button 
to customize 
the color 
for these cells.

Be sure your values 
match those shown here.
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10. To help you create multiple conditional formatting rules for the same column, you can 
use the Clone Rule icon. From the Rule 2 heading bar, click the Clone Rule icon. Rule 3 
now appears. The Field Name, Operator, and Value fields are populated automatically 
based on the rule you cloned. 

11. In the Rule 3 section, from the Value drop-down field, select Silver.

12. From the Cell Color drop-down field, click Custom. The Custom Color dialog box opens.

Be sure to click 
the Clone Rule icon 
for the correct rule.

Be sure to change 
the value for this field.
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13. Set the following values:

g Red = 139
g Green = 155
g Blue = 151

14. Click OK to close the Custom Color dialog box.

15. In the Conditional Formatting Rules dialog box, on the Rule 3 heading bar, click the 
Clone Rule icon. Rule 4 now appears.

Be sure your values 
match those shown here.
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16. In the for Rule 4 section, from the Value drop-down field, select Bronze.

17. From the Cell Color drop-down field, select Custom. The Custom Color dialog box opens.

18. Set the following values:

g Red = 200
g Green = 116
g Blue = 90

19. Click OK to close the Custom Color dialog box.

20. Click OK to close the Conditional Formatting Rules dialog box.

Be sure your values 
match those shown here.
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Exercise 11: Generate 
a Scorecard for a 
set of investments

Conditional formatting is helpful, but it still is not clear which funds have actually 
performed consistently well. Remember, your manager stated that to be considered a 
top performer, a fund had to be in the top quartile at least 75% of the time over these 
time periods. This calculation can be done with the Scorecard feature. A new column 
will be added to each time period, as well as to the right side of the report for the Total 
Score of each fund across these time periods.

In this instance, each time a fund appears in the top quartile of its category for a time 
period, it will be given a score of one point. If it is not in the top quartile, it will not 
receive any points. Once you add a scorecard to a performance report, you will need to 
recalculate the report. 

To create a Scorecard for this set of investments, do the following:

1. From the toolbar above the grid view, from the Edit drop-down field, select Scorecard. 
The Investment Scorecard dialog box opens.

2. In the Scoring Type area, select the Custom Scoring option.

 Note: When the Performance Reporting warning message opens related to all formatting 
being lost, click Yes.

3. In the Performance Factors area, click Add Score. The Custom Score Setting dialog 
box opens.

Select this option from the 
Edit icon’s drop-down field.

Use this icon to 
create your 
custom scorecard.

Be sure to select 
this option to 
create your own 
scoring rules.
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4. The Time Period field should read All Time Periods. From the Data Point/Rank Selected 
drop-down field, select Return: Peer group %.

5. In row 1, enter the following values:

6. Click OK to close the Custom Score Setting dialog box.

7. Click OK to close the Investment Scorecard dialog box.

8. From the toolbar above the spreadsheet grid, click Calculate.

9. When the confirmation message opens, click Yes to view the report.

Operator Value1 Score Display

<= 25 1 1

Note the 
highlighted 
values for 
this rule.

Because the parameters of 
the report have changed, 
it needs to be recalculated.



Creating a Performance Report Exercise 12: Add a summary column for various scores

Morningstar Direct January 2020 31
© 2020 Morningstar. All Rights Reserved.

10. To see only the scores, from the toolbar above the grid view use the View drop-down 
field to select Score Columns. Note the new Total Score column on the far right side.

Exercise 12: Add a 
summary column 
for various scores

The information in the score columns is useful, but it would be nice to summarize the 
scores, and then analyze the funds. How many have been truly consistent over all 25 
time periods? Do the following:

1. From the toolbar above the spreadsheet grid, from the Edit drop-down field, select 
Scorecard. The Investment Scorecard window opens.

Select this option 
to see only the 
score columns 
for the report.

The Total Score 
column was 
added to 
the report.

As before, use this 
option to create a 
scorecard column.
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2. From the toolbar in the Performance Factors section, click Add Score. The Custom Score 
Setting dialog box opens.

3. From the Time Period drop-down field, select Score. The Data Point/Rank Selected 
drop-down field should show Total Score.

4. In row 1 under Default Display, enter the following values:

Operator Value1 Display

= 25 Consistent Performer

Click this button to 
create an additional 
score column.

Select this option 
to summarize the 
scores on the report.
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5. Click Insert Rule to create the following rule:

6. Click OK to close the Custom Score Setting dialog box.

7. Click OK to close the Investment Scorecard window.

8. From the toolbar above the grid view, click Calculate.

9. When the confirmation message opens, click Yes to view the report.

10. Scroll to the right and double-click the Total Score column header to sort the content 
of this column.

Exercise 13: Save 
investments to a list

Now that you know which funds should be considered consistent top performers, you 
can do further analysis on the portfolio of each one. The first step is to save these items 
to a list. Do the following:

1. For each fund in the Large Growth category marked as a Consistent Top Performer in the 
Total Score column, click the checkbox to the left of its row number

2. From the toolbar, from the Save drop-down field, select Save as Investment List. The 
Save As dialog box opens.

3. In the Name field, type Large Growth Consistent Performers.

4. Click OK. 

You have now successfully generated a Performance Report, and saved the securities to 
a list for further analysis. To conduct that analysis, you will use the Portfolio Analysis 
module, which is covered in the next section.

Operator Value1 Display

< 25 Do Not Consider

Be sure to select 
the correct option 
to save these items 
to an investment list.
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